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Introduction
This guide is an introduction to the  software used to solve crystalline phase identification.HighScore Plus

HighScore for scientists is available on a virtual computer onboard in the Core Lab. 

To access the Remote desktop click on the Windows tab   and type 'remote desktop', this will bring you to a window to enter an IP address (Figure 1
). Click .Connect

 The remote desktop can be accessed from any PC onboard (Windows system only).Only one person can use the remote desktop at one time.

IP address: 165.91.150.141

Username: daq

Password: daq

Figure 1. Connection to the Remote Desktop to use HighScore plus software

To disconnect from the virtual computer, move the mouse up screen to reveal the disconnecting options.

Getting Acquainted

To open the software double click the  icon  on the computer desktop.HighScore Plus

You can customize the main screen for your own requirements; the most common desktop used is for phase identification (see Phase-ID HighScore: 
below). The  desktop can be selected on the bottom right toolbar in the dropdown menu  or via Select Phase Identification Phase-ID ( , arrow A)Figure 2 Vi

     in the dropdown menu ew > Desktop > Desktop Name > Phase-ID ( , arrow B).Figure 2
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Figure 2. Setting the main screen to Phase-ID desktop

For the  Desktop display, there are three main windows ):Phase-ID (Figure 3

The  pane shows the scan and/or scans in the tab (circled in green).Main Graphics Analyze View 
The  pane displays the zoom overview.Additional Graphics
The pane is the third panel on the right of the screen. It is used to examine the , , , Patterns and List Peak List Scan List Quantification Graphs
and the  tabs.Anchor Scan Data



Page 3 of 14

1.  
2.  
3.  
4.  

Figure 3. Basic Layout of the "Phase-ID" desktop

Opening a Diffractogram in HighScore Plus

To open a diffractogram for evaluation, click >  ( ).File Open Figure 4

Figure 4. Open Scan

Select the file you want to open.  software can import files produced by Bruker D4 XRD or Panalytical AERIS XRD in the X-ray lab. The HighScore Plus
valid file formats include , (Bruker) and (Aeris) files..raw .uxd  .xrdml 

If you do not see the file you are looking for: in the field , select . . This will bring up XRD files produced by the Bruker D4 or Files type All files ( )
Panalytical AERIS.
You can select multiple files; each one will open in its own window.

Click  The scan is now open and ready for evaluation (see ).Open. HighScore: Phase Identification

HighScore: Phase Identification
Diffraction pattern treatment is used for phase and crystallographic analyses. The two most important treatments are background determination and 

 A proper background determination is very important for phase analysis.peak search.

There are several steps used when you want to determine the identity of the unknown phases in the diffraction pattern:

Background determination
Peak search
OPTIONAL – Strip K-2 Signal
Peak Search and Match

Background determination

Background fitting is often easier if the y-axis is set to 'Square Root Y-axis' ( ). To determine the background, select  > Figure 5 Treatment Determine 
e background is automatically determined (fluo green line on the diffractogram in Background ( ). ThFigure 6 ). Figure 6

The  window will show on the screen (Determine Background ).Figure 6



Page 4 of 14

Figure 5. Useful display options

Figure 6. Determining Background

Automatic background fitting is most often used. Adjust parameters until the green background line is a good fit to the data, without overfitting or 
underfitting the data. You will want to choose your  and a bending factor granularity.

You can change the  by moving the slider on the Determine Background window. This field adjusts the nonlinearity and curvature of the Bending factor
background. Typical values are between 0 and 4 (normally a small number 1-2 fits well). 
You can change the  by moving the slider. This field changes the number of intervals used for background determination. Typical values range Granularity
between 10 and 30. The default value of '20' fits most ordinary scans.

Tick the box 'Use smoothed input data' to avoid oversampling.

When the background is fit, click  to accept the background ( ). The  window is closed and the accepted Accept Figure 6 Determine Background
background is displayed as a dark green line on the pane (see ).Main Graphics Figure 7

Search Peaks
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Select  > The  window opens ( ). Adjust the peak search parameters if needed (Figure 7). The default Treatment Search Peaks. Search Peaks Figure 7
settings are a good starting point. The  is a calculation of the probability that a possible peak is not noise-induced. A large significance minimum 

 above 2 or more is useful for noisy data. Normally you should not have to adjust the other values. Once you are happy with the parameters, significance
click  ( ). Search Peaks Figure 7

Figure 7. Search Peaks

Detected peaks are displayed above the  pane by orange lines (green box in ). A calculated pattern based on the peak search is Main Graphics Figure 8
shown in pink over the experimental data shown in red.

Click on ('Set Display of Peaks') to toggle the display of peaks.

K-1 peaks are indicated by solid lines
K-2 peaks are indicated by dotted lines
Peaks that are not explained by a reference pattern have a little 'V' mark.
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Figure 8. Selected peaks and accept peaks.

When you are happy with the results, click  button ( ).Accept Figure 8

In the  pane, click on '  tab to show the numerical details on every detected peaks ( ).'Patterns and List' Peak List' Figure 9
In the , you can right click on a row to '  or '  or ( ). Peaks derived Peak List Add Peak' Delete Peak'  'Remove Selected Peak Features from Scan' Figure 9
from the K-2 wavelength are indicated by a different (gray) background color ( ). Deleting certain peaks will help the software to focus on specific Figure 9
peaks for mineral searching. This can be helpful if you have a multiphase (multi mineral) bulk sample.
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Figure 9. Peak List displaying the numerical details of the detected peaks from the Peak Search

Strip K-2 Signal (OPTIONAL)

This step is  and not necessary for phase analysis or other analyses you can do in HighScore Plus. K-2 radiatioOPTIONAL n can be computationally 
stripped from the data because the relationship between K-1 and K-2 radiation is very well known.

Primarily you remove the K- peaks from the diffraction pattern to clean up the data or make it easier to evaluate good and/or poor matches. 
To remove the K-2 signal form your data:
Select ( , arrow A). Click the  button (arrow B), then click the  button (arrow C).Treatment>Strip K-Alpha2 Figure 10 Strip K-2 Replace
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Figure 10. Stripping the K-2 signal

Peak Search and Match

Once you have determined the background and searched for peaks the next step is to match the peaks. 
Select  >  > ( ).Analysis Search & Match Execute Search & Match Figure 11
The  window appears with a default parameters set ( ). For initial searching the ' ' parameters are fine to start with. You Search & Match Figure 11 Default
can adjust the parameters as necessary.

Data Source: Best results when you use Peak & Profile Data
Peak Data is the peak list produced from your peak search.
Profile Data is all observed intensity above the background model produced when you fit the background

Scoring Scheme: Set this to Multi Phase. Only use single phase if you want to force program to use a single phase to match all the 
observed data.
Auto Residue: Make sure you select this. When you accept a candidate as a good match all of the remaining candidates are rescored 
based on how well they fit the unmatched features.
Match Intensity: if this is off, the quality of the match is based only on agreement of peak positions; if this is on, the score reflects the 
quality of the intensity match as well.
Demote unmatched strong: if on, if a candidate has one strong (>50%) peak missing in the observed data then the candidate is 
discarded—no matter how well the rest of the peaks match.
Allow pattern shift: if on, each reference pattern is shifted for an optimal fit with the data. The maximum allowed pattern shift is ± 4 x 
FWHM.

Click ( , red box).Search Figure 11



Page 9 of 14

Figure 11. Peaks Search and Match

List of the possible matches is displayed on the lower portion of the pane ( ). Click  to accept ( , red box). Pattern List Figure 12 OK Figure 12
The  list shows entries ordered by high to low score based on how well they match the experimental data ( ).Candidates Figure 12

Figure 12. Candidates List ordered by strongest and weakest matches.
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The next step is to manually accept candidates that have a high score and that match the peaks and features of the measurement.

For that, select and drag the matching candidate patterns from the  list to the  list in the upper half of the  Candidates Accepted Ref. Patterns Pattern List
tab to accept it ( ). When you select matching patterns, it is highlighted in gray and lines are displayed in the  and Figure 13 Main Graphics Additional 

 panes ( . Peaks will lose the "V" mark above the line. These peaks have been explained by the reference pattern. Peaks with a "V" Graphics )Figure 13
have not been explained and/or matched ( ).Figure 13

There are several views in the  pane to support the visual comparison between reference pattern sticks and the measurement. For Additional Graphics
instance:

Select orView > Additional Graphics > Compare Mode   
Select View > Display Mode > Show Calculated Profile

Figure 13. Move accepted peaks from the  sub-panel the  sub-panelCandidates Accepted Ref. Patterns

To check if the accepted patterns are indeed minerals and comply with the sample description, right-click a specific reference pattern in the Accepted Ref. 
 list. Select  to view the subfile information of that pattern ( ).Patterns Show Pattern Figure 14
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1.  
2.  
3.  
4.  

Figure 14. Information on an accepted reference pattern

If you wish to save the complete file (including the candidate list and the accepted reference patterns), click . HighScore Plus file File > Save Document
format is .hpf.

HighScore: Rietveld Analysis: Quantitative Phase Analysis
To complete a quantitative phase analysis you will use the  in  software.Rietveld refinement HighScore Plus

Starting Quantitative Phase Analysis

Before completing the quantitative phase analysis, make sure you have completed all of the phase identification steps (see HighScore: Phase 
above):Identification 

Determine the background
Search peaks
OPTIONAL: Strip the K-2 signal
Peak Search and Match

Now you are ready to complete quantitative phase analysis using the . This method is a full pattern fit method. It is typically used for Rietveld method
standardless, quantitative phase analysis.

Setting up your desktop layout

Select the desktop layout from  to  on the Desktop toolbar ( , arrow A). Or       Phase-ID Rietveld Analysis Figure 15 View > Desktop > Desktop Name > Rietve
ld Analysis.
In addition to the  and  pane, available on the Phase-ID desktop as well, there are two other panes: Main Graphics Additional Graphics Refinement 

 and  ( ).Control Object Inspector Figure 15
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Figure 15. Rietveld Analysis Desktop Layout

Start Analysis

Select . Check that the option  is set to ( ). Correct if necessary.Analysis > Fitting Fitting Mode Automatic Figure 15
Select > and then select  to start the refinement with the default Rietveld parameters set (Analysis > Fitting > Start Fit <Phase fit> Default Rietveld Figure

, arrow B). Wait until it is finished, this may take a few minutes.15

The peaks and the calculated profile are in the  pane. In the 'Refinement Control' tab in the  pane on the main display, Main Graphics  Refinement Control
double-click the  ( , arrow A) to open the 'Object Inspector' pane ( ). Select to Global Variables Figure 16 Figure 16 Global Settings>Agreement Indices 
view the values of the  and   (Goodness of Fit Weighted R profile , arrow B).Figure 16
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Figure 16. Refinement Control pane displaying the . The  can be used to look at the fit properties  Refinement Control, Global Variables Object Inspector
and agreement indices.

Display the Phase Amounts

The phase amounts will automatically be displayed together with the phase legend in the  pane once the Rietveld analysis is completed (Main Graphics Fig
Alternatively, you can open the 'Quantification' tab in the  pane and view a pie chart of the quantification ). ure 17A Refinement Control ( ).Figure 17B
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Figure 17. A. Phase amounts as a percentage are displayed on the main graphics window. B. Pie chart of the phase amounts for the quantification of the 
phases

Export and Save a File

To export a file or save the file as a working file, click >File Save As.
Save the document as a  file (this is the HighScore working file format)..hpf

Archive Versions

HighScore Software QSG (Original Version 378) - 290220
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